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MaxLoad Pro is designed to the loading of mixed SKUs onto pallets, truck and containers. 

This tutorial is designed to give a general overview of the primary functions of the software.  The 

tutorial does not explore the full range of the MaxLoad Pro software capabilities, but is designed 

only as a basic tutorial that walks you through the core of the system. 

This tutorial is organized into four sections: 

Getting Started:  Walks you through the process of logging into the system. 

Exercise #1:  Load a Truck Manifest:  Walks you through a truck manifest, whereby you’ll use 

MaxLoad Pro to find the optimal solution for loading mixed-size stock keeping units (SKU’s) 

into a transit vehicle. 

Exercise #2:  Load a Pallet Manifest:  Walks you through a pallet manifest, whereby you’ll use 

MaxLoad Pro to find the optimal solution for loading mixed-size SKU’s onto a pallet. 

Exercise #3:  Load a Tote Manifest:  Walks you through a tote manifest, whereby you’ll use 

MaxLoad Pro to find the optimal solution for loading SKU’s into a tote or shipping carton. This 

function is often used to select the most optimal shipping carton for retail order. 

Exercise #4:  Load a Single-SKU Manifest:  Walks you through a single-SKU manifest, 

whereby you’ll use MaxLoad Pro to see how to cube out a truck or container for a particular 

SKU, as floor loads or uniform pallets. 

 

 

 

If you experience problems or difficulties while using the MaxLoad Pro software, please call 

your Account Manager or the TOPS Technical Support Department at 972.739.8677. 
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Login to the System 

To start the program and login to the system, follow these instructions: 

1. From your desktop, double-click on the MaxLoad Pro icon in the TOPS for Windows Apps 

group.   

 
 

2. Select Export Department (or any username), and then click on the Login button. 

If you log in as Supervisor which allows you access to additional configuration settings, the 

default password is “tops software”. We advise the license holder to change to a secure 

password if you do not wish all users to have access.  
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The Control Center is the starting point for all your work in MaxLoad Pro.  From the Control 

Center, you can start any of four types of manifests – truck, pallet tote, or single-SKU – each of 

which is represented by an icon.     

• Truck Manifest:  Determines the most efficient way to load mixed-size SKU’s into a 

transit vehicle.  SKU’s can be defined as cartons, cylinders or pallet loads.  A transit 

vehicle can be any type of 3- dimensional end-loading rectangular object, such as a truck, 

ocean container or airfreight container. 

• Pallet Manifest:  Determines the most efficient way to place mixed-sized SKU’s onto a 

pallets.  Solutions of mixed pallets can be fed to robotic palletizers. 

• Tote Manifest:  Determines the most efficient way to place a variety items, or SKU’s, 

into a tote (shipcase). The Tote function is most commonly used in retail packing. 

• Single-SKU:  Determines the most efficient way to completely load one transit vehicle 

with a single-size SKU (palletized or non-palletized).   
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Exercise #1:  Load a Truck Manifest   

This exercise walks you through a truck manifest, whereby you’ll use MaxLoad 

Pro to find the optimal solution for loading mixed-size SKU’s into a transit 

vehicle.  Follow these instructions: 

1. From the Control Center, click on the New button on the Truck Manifest 

icon.   

 

2. From the Available Vehicles list, select “53 Ft. Dry Van” by double-clicking on the vehicle 

name to select it. The vehicle will be added under Selected Vehicle. 

3. Scroll through the SKU List to see the database of SKU’s that are already defined in the system.  

To select an SKU for the manifest, double-click on it.  In this exercise, we’ll select the 

following SKU’s: Case #4, Computer, Large Drum and Pallet #1 

4. Type in a quantity for the first SKU, then press Enter.  The cursor moves to the Quantity field 

for the next SKU.  Repeat this step for each SKU.  For this tutorial, enter the following 

quantities: 

• Case #4:  138 

• Computer:  40 

• Large Drum:  40 

• Pallet #1:  16 

After you’ve selected the SKU’s listed above and keyed in the quantities, the Manifest Pick 

List screen should be like the one pictured below. 
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5. If all the SKU’s and quantities are correct, click on the “Calculate” button. 

           

Notice some things about the Manifest View screen: 

• The Toolbar provides buttons that allow you to progressively load/unload the 

manifest solution - 
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• The Manifest Solution View Screen displays a 3-dimensional graphic of the loaded 

vehicle. With the graphics in focus (with mouse placed in this area), you can use the 

arrow keys to rotate the view of the solution. 

• The load statistics on the left, provide data such as weight, cube and center-of-gravity 

statistics, including any estimated axle weight calculations, if applicable. 

• A number of lists – Solution (Sol) List, Placement List, Load List and Cut List, etc – 

are represented by the tabs at the bottom of the screen.  These lists provide additional 

load statistics.  To display a list, click the list tab. 

6. When you’ve finished with this load, go to the Menu Bar, open the File menu and select Save 

As. 

7. Type in “Tutorial,” then click on OK. 

8. To print this solution, go to the Menu Bar, open the File menu, select Print Preview, and then 

select Load from the sub-menu.  

 
 

9. Select the view you want to use in the Print Preview.  In this exercise, we’ll select the default 

(3D Front).  Click on OK. 

Please note:  MaxLoad gives you the ability to create custom reports, only displaying the 

information you want to show.     
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10. To add text to the Print Preview, click on the Edit button.   

11. Use the mouse pointer to click on the place in the diagram where you want to add text. 

12. Key in the text that you want to appear on the printout. 

13. When you’re finished, click on the Finished button. 

14. If everything is to your liking and you’re ready to print, click on the Print button. 

 

Add Additional SKU’s to the Truck Manifest 

Now that we’ve printed the solution, let’s modify the load slightly.  In this part of the exercise, 

we’ll remove SKU’s from the load, add other SKU’s to the load and place certain SKU’s onto a 

pallet, for ease of loading.   

To modify the manifest, follow these instructions: 

1. From the Manifest View Screen, click on the Pick List button.   

2. Click on the Options tab. 

3. Click on the Use Unit Loads and Use Mixed Pallets check boxes to turn on those features.   

4. In the Manifest List, activate the UL and MP columns for Case 4 by clicking on the check 

boxes.  Be sure the UL and MP boxes remain unchecked for the other three SKU types. 
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5. From the SKU List, select the Refrigerator SKU. 

6. Enter a quantity of six for the Refrigerator SKU. At this point, the Manifest List should look 

like the one pictured below. 

  

7. If everything is correct, click on the Calculate button. 
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8. From the Manifest View screen, click on the Edit button. 

         

Notice that in the Editor screen above, all the placements in the vehicle are labeled – Large 

Drum, Pallet #1, etc.  For this section of the exercise, we’ll label everything in the load in 

order to make a couple of points in the editing process.  To have MaxLoad Pro automatically 

label the load placements, click on the Labels button –  – in the toolbar. 

The Editor screen is divided into two sections.   

• The Cut List, on the left side of the screen, contains a listing of all SKU’s that were 

not loaded into the vehicle. 

• The load solution is displayed as a 3-dimensional graphic on the right side of the 

screen. 

Notice that the Cut List contains 14 large drums and 12 computers.  Let’s say we want to 

make sure all computers are shipped with this load.  To do this, we must remove a group of 

items to make room for the computers. For the purposes of this exercise, we’ll remove two 

placements of large drums indicated by the arrows in the screen above. 

9. With the mouse pointer, click on any SKU within the placement of large drums and drag the 

placement of large drums out of the vehicle and over to the Cut List.  As you drag the group, 

notice that it appears in outline form, while the actual placement remains in the vehicle.  After 

you’ve moved the first placement, move the second placement of two large drums from the 

rear of the vehicle. 
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10. Once your mouse pointer crosses over the border that divides the solution window from the 

Cut List, release the mouse button. Note the quantity of Large Drum increases from 14 to 22 

on the Cut List. 

 

12. Now we want to add the 12 Computers onto the vehicle.  Click on the Computer SKU in the 

Cut List which opens the Computer SKU is an Orientation Box as shown below. 
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13. Click on the Computer SKU in the Orientation Box, drag and drop it to the space left empty 

by the Large Drums as shown below. Notice the count of Computer in the Cut List has been 

reduced by 1. 

 

14. To add another computer, repeat the same maneuver as in the previous step. 

Note: A quick trick to quickly add the same Computer SKU (to create a placement) is to hold 

down the [Shift] and click the face of the SKU where addition will take place. For example, 

click the face of the SKU will build the placement as below. 

 

15. Continue to add Computers to the load until all 12 have been moved from the Cut List to the 

vehicle.  When you’re finished, the Editor screen should look like the one pictured here. 
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At this point, notice two things about the Editor screen: 

• There are no Computers in the Cut List; they’ve all been moved to the vehicle. 

• There’s still some unused space on the vehicle. We’ll try to load back some Large 

Drums. This can be done manually in steps as described earlier; we can also use the 

placement button. 

16. From the Toolbar, click on the Put All button     . This button tells MaxLoad Pro to load as 

many of the remaining SKU’s onto the vehicle as will fit. 

MaxLoad Pro moves two of the Large Drums from the Cut List to the vehicle, in front of the 

newly placed Computers.  The vehicle is now fully loaded.  

17. If you’re satisfied with this load solution, click on the Save button 
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Exercise #2:  Load a Pallet Manifest 

This exercise walks you through a pallet manifest, whereby you’ll use MaxLoad 

Pro to find the optimal solution for loading pallets into a transit vehicle.  Follow 

these instructions: 

1. From the Control Center, click on the New button on the Pallet Manifest icon.  

 

2. From the Pallet drop-down list, select “GMA Notched” which is a commonly used 48”x40” 

inch pallet. 

3. Enter dimensions for maximum height, weight and overhang, as follows: 

• Maximum Height Incl Pallet:  65 inches 

• Maximum Weight Incl Pallet:  9999 pounds 

• Maximum Length Overhang:  1 inch 

• Maximum Width Overhang:  1 inch 

4. From the SKU List, select the following SKU’s: 

• Case 1 

• Case 3 

• Case 5 

5. Type in a quantity for the first SKU, then press Enter.  The cursor moves to the Quantity field 

for the next SKU.  Repeat this step for each SKU.  For this tutorial, enter the following 

quantities: 
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• Case 1:  10 

• Case 3:  10 

• Case 5:  10 

 

After you’ve selected the SKU’s listed above and keyed in the quantities, the Manifest Pick 

List screen should look like the one pictured below. 

 

6. If all your SKU’s and quantities are correct, click on the Calculate button.   
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The Manifest View screen for a pallet manifest looks almost identical to the Manifest View 

screen for a truck manifest: 

• The Toolbar provides buttons that allow you to progressively load/unload the manifest 

solution. 

• The manifest solution section displays a 3-dimensional graphic of the loaded vehicle. 

• The load statistics to the left of the graphics provide weight and cube data. 

• A number of lists – Solution (Sol) List, Placement List, Load List and Cut List – are 

represented by the tabs at the bottom of the screen.  These lists provide additional load 

statistics.  To display a list, click that list button. 

Under Algorithm column in the Sol List tab, there are different solutions, with different loaded 

quantity. Click on the Cut List to see remaining SKU which do not make onto the pallet. 

7. Click on the Next button to load the remaining SKUs onto a second pallet. The following 

message asks to confirm you will select the current solution for the first pallet. 

 

Once click on OK to confirm, you will see the second pallet with the remaining SKUs. 

Note: MaxLoad has an option called “Calc All Trucks” and when enabled, will load the entire 

shipment and let you know how many pallets (or trucks if for Truck Manifest) will be needed, 

Ask your Account Manager about this function. 

8. When you’ve finished with this load, go to the Menu Bar, open the File menu and select Save 

As. 

9. Type in “P Tutorial,” then click on OK. 

10. To print this solution, follow the same instructions outlined in Exercise #1. 

11. As with the truck manifest exercise, you have the option to edit the solution.  All edit options 

outlined in Exercise #1 are available for editing a pallet manifest.  See Exercise #1 of this 

tutorial for detailed instructions on how to edit a solution.   
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Exercise #3:  Load a Tote Manifest 

To create a new tote manifest, start from the Control Center and follow these 

instructions: 

1. Under the Tote Manifest box, click on the New button. 

 

 

2. From the Tote List, select the tote (shipcase) that you want to use to create the new tote 

manifest.  You’ll place your SKU’s into this tote (shipcase).  To select a tote from the Tote 

List, double-click on it.  In this exercise, we’ll select 45x40x40 Tote. 

3. From the SKU List, select the specific SKU’s that will be placed into the tote.  In this 

exercise, we’ll select Cookies, Potato Chips and Saltines.  To select a SKU, double-click on 

it. 

4. Define the quantity of each SKU that will be placed into the tote.  In this exercise, we’ll define 

SKU quantities as follows: 

• Six (6) Cookie SKU’s 

• Two (2) Potato Chip SKU’s 

• One (1) Saltine SKU 

5. If everything is correct click on the Calculate button. 
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Notice the following about the View Screen: 

• MaxLoad Pro has calculated two tote manifest solutions, which are listed at the bottom 

of the screen.  The View Screen displays the first of the two solutions.  Note that the 

number of solutions available depends on the Algorithms selected under the Options 

tab in the Manifest Pick List screen.  

• The tote display shows the nine SKU’s – six Cookies, two Potato Chips and one Saltine 

– placed inside the tote (shipcase). 

• The first solution was calculated using the Left/Right Front to Back algorithm. 

6. Select the tote manifest solution that best meets your needs. 

7. From the Menu Bar, open the File menu and select Save As. 
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Saving Tote Manifest as a SKU 

 

1. In the blank line at the top of the box, replace the word “Untitled” with the name of this tote 

manifest.  In this exercise, we’ll save this tote manifest with the name of “Snack Products.” 

2. Check the Save As SKU box. 

3. Click on OK and the following dialog appears as shown on right. 

4. In the blank SKU field, give the tote manifest a SKU name e.g. 

“SKU999.”  Click on OK. 

Note:  MaxLoad saves the new tote SKU to the SKU database and 

returns you to the View Screen.  The next time you open a tote 

manifest, the “Snack Products” tote will be listed in the File Open 

dialog box.  You will also see SKU999 in the SKU List on the Manifest Pick List Screen. 

 

5. To see a report of the new tote manifest, open the File menu and select one of the Print 

Preview options   
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Define a SKU 

To define a SKU, follow these instructions: 

1. From the Menu Bar, open the Define menu and select SKU. 

 

2. In the SKU Style field, select an SKU style.  For this exercise, select Shipcase. 

3. In the SKU Number field, enter an SKU number.  This field is alphanumeric and holds a 

maximum of 32 characters.  For this exercise, enter “Test SKU.” 

4. In the Description field, enter a more informative description.  Again, this is an alphanumeric 

field that contains a maximum of 50 characters.  This field is optional.  For this exercise, enter 

“Tutorial Test SKU”. 

5. In the Length, Width, Height and Weight fields, enter the following dimensions: 

• Length:  15 inches 

• Width:  12 inches 

• Height:  14 inches 

• Weight:  10 pounds 

6. In the Allowed Vertical column, select the dimensions that are Allowed Vertical.  For this 

exercise, we’ll allow only the Height dimension to be vertical. 

Note that if all dimensions are allowed vertical, you can specify the preferred dimension to be 

vertical in the Preferred Vertical column. 

At this point, the Define SKU screen should look like the one pictured on the next page. 
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7. If everything is correct, click on the Save button. 

 

Create a Unitload for the SKU 

Let’s take this exercise one step further and create a unit load for our SKU.  Follow these 

instructions: 

1. From the Define SKU screen, click on the Create UL button. 

2.  

 
 

2. From the Pallet drop-down list, select GMA Notched.  MaxLoad Pro includes a number of 

predefined pallet styles you can choose from. 

3. In the Maximum Height Incl. Pallet field, enter 55 inches. 

4. In the Maximum Weight Incl. Pallet field, enter 9999 pounds. 

5. In the Maximum Length and Width Overhang fields, use the default of one inch. 
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6. If everything is correct, click on the Calculate button.   

 
 

Notice that MaxLoad Pro has calculated multiple solutions, which are listed at the bottom of 

your screen.  If you scroll through the solutions, you’ll notice that all solutions are no taller 

than 55 inches, no heavier than 9999 pounds and utilize no more than one inch of overhang 

over both the length and width of the pallet.   

7. Use the scroll bar on the right side of the solution list to look through the different solutions.  

For this exercise, we’ll select the first solution listed.  This pallet pattern contains three layers 

of 11 SKU’s for a total of 33 SKU’s in the unitload. 

8. To accept this solution, click on the OK button.   

9. Click on the Save button again, then click on the Close button to exit this screen.   

The selected pallet pattern selected will now be associated with the newly defined SKU.  

Whenever you select “Test SKU” and tell MaxLoad Pro to Use Unitloads, MaxLoad Pro will 

use this pallet pattern. 
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Exercise #4:  Load a Single-SKU Manifest 

This exercise walks you through a single-SKU manifest.  MaxLoad Pro will find 

the optimal solution for loading single-size SKU’s into a transit vehicle.  The 

purpose of the Single-SKU module is to instantly determine how much of a single 

type of SKU will fit into a container. 

This module does not allow you to input quantity; you simply choose an SKU, click 

Calculate, then view multiple solutions, all of which represent different ways to “cube out” a 

container with the one type of the SKU selected.  First, let’s walk through how to define an SKU.  

We will then use our newly defined SKU as part of our single-SKU load analysis.   

 

Define the Single-SKU Manifest 

At this point, we’ve defined a new SKU and created a unitload and pallet pattern specifically for 

the new SKU.  Now we’re ready to define the pallet manifest.  Follow these instructions: 

1. From the Control Center, click on the New button on the Single-SKU Manifest icon.   

2. In the Vehicle Type box, select Sea Van.   

3. From the Available Vehicles list, select 45 Ft. H.C. (high cube) Sea Van.   

4. Scroll down the SKU List and select “Test SKU.” At this point, the Manifest Pick List Screen 

should look like the one pictured here. 
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Note that the UL (unitload) option is prechecked as MaxLoad Pro finds a unitload already 

defined for this SKU. 

5. Click on the Calculate button. 

 

Unlike a truck manifest, which involves multi-size case loading, only one set of statistics 

appears at the bottom of the screen.  These statistics display information regarding the 

orientation of the SKU (i.e., which dimension is vertical), the pattern type used in the 

analysis, cases per layer, layers per vehicle, cases per vehicle, area efficiency, cubic 

efficiency and weight efficiency. 

Notice that the pallet pattern used was the one selected earlier when we created a unitload.  

Looking at the first solution, as highlighted in the figure above, the load statistics now show 

us the following: 

• 1,518 “Test SKU’s” were loaded into the vehicle.  

• The SKU’s are divided between two layers of unitloads, with 23 unitloads per 

layer.   

Using this method of loading, 93.4 percent of the available floor space is used (area 

efficiency), 82.8 percent of the available cubic capacity is utilized (cubic efficiency) and 40.4 

percent of the maximum allowable weight of the vehicle is use. 

6. To load Test SKU as floor loads, click the PickList button to go back to the Manifest screen. 

7. Uncheck the UL option and click on Calculate again. 
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Without Test SKU being palletized, the first solution shows us the following: 

• 1,918 cases of “Test SKU” were loaded into the 45 Ft. High Cube Sea Van 

• It took seven layers of 274 SKU’s each to cube out our vehicle.   

• We utilized 99.3 percent of the available floor space of the vehicle (area efficiency), 

91.8 percent of the cubic capacity (cubic efficiency) and 42.6 percent of the 

maximum allowable weight of the vehicle. 

You can view other solutions by clicking on the respective solution in the solution list.  The 

diagram will redraw each time you select a different solution. 

To save this solution, go to the Menu Bar, open the File menu and select Save As.  In the 

Save Manifest dialog box, enter “Tutorial 2,” then click on OK. 


